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1. Obijectives

The objective of this tutorial is to become familiar with the following:

Using the PSCAD menus and tools
Using the Master Library
Inserting components and wiring
Entering data

Running a case

Tutorial: Creating a Simple Circuit
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Tutorial: Creating a Simple Circuit

2. Creating a Simple Circuit

This section provides instructions for creating and running a simple circuit. This consists of inserting components
and wiring, and running the case. Some initial steps are required, including setting the viewing panes and creating
a new project.

2.1

Displaying the Viewing Panes

There are several viewing panes that will be used throughout this tutorial. Ensure the required viewing panes are
displayed as follows:

a.

b.

Left-click on “Panes”.

Left-click on the “View” menu.

% PSCAD (64-bit) Professional

pu'.“.“m| Home Project View Tools
u I:‘ Bounds Signals
l:' Bus Monitoring l:' Sequence
SWItEh | 1 Grids [ | virtual

Nindov

VAT o e oy i T
wWindow Canvas Overlays
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c. Place a checkmark against the following five panes as shown:

| Panes |

-

v | Build Messages

v | Component Parameters
Component Wizard
Make File
Map File

v | Runtime Messages
Search
Search Results

v | Start Page
Support Request

v | Workspace

2.2  Creating a New Project

Create a new project in accordance with Appendix A. Name the case “NewCase”

Tutorial: Creating a Simple Circuit
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2.3 Inserting Components
Insert components as follows:
a. Insert a power source into your project as follows:

e Insert the following power source from the Master Library in accordance with Appendix B.

Component: masterzource_3

Instance: 36335620

Dezcription: Three Phaze Yoltage Source Model 2
Mame: Source 1

Sequence; [

Caonnection [M5]

Source_3: Star connection
Sources

e Your layout should look similar to the following:

master:Main.Sources\ Start Pagel NewCase:Main \E\I

Note

To move any of the components to a different location on the canvas, use the “drag and drop” method
(position the cursor over the component, hold the left mouse button down, move the cursor to the new
position, then release the mouse button).
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b. Insert a resistor from the “Components” menu in accordance with Appendix C. Your layout should look
similar to the following:

A
1.0 [ohm]

¢
1

c. Insert and configure a second resistor as follows:

e Right-click on the first resistor. In the displayed menu, select “Copy”.

RV
1.0 fohm} Paste

e Position the cursor on the canvas, right-click, then select “Paste”. A second resistor will be created and
pasted to the canvas.

A
1.0 [ohm]

o Cut
n!_'(Jf) Cop
fsse)
1

x
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e Right-click on the second resistor, and select “Rotate Right” from the menu.

Cut
Co
AR Y
1.0 [ohm] Paste
Delete
Rotate Left

Rotate Right

e The resistor will rotate, and your layout should look similar to the following:

A
1.0 [ohm]

1

e Left-click on the second resistor. The default resistance will display in the “Component Parameters”

pane.
Component Parameters 1 @
| Configuration
=3
4 General
Resistance 1.0 [ohm]
Note

If the Component Parameters pane is not displayed, display it in accordance with Step 2.1.
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e Left-click in the field next to “Resistance”, delete “1.0”, and keyboard “250”.

Component Parameters 1 @
|Conﬂgurati0n
=3
4 General
Resistance 250[ohm]

d. Insertaground as follows:

Insert the “Ground” from the “Components” tab in accordance with Appendix C. Drop the ground near

the second resistor, as shown:

¢
1

e Right-click on the ground, and select “Rotate Right” from the menu.

A
1.0 [ohm]

(wyol gz
AR

Delete

Rotate Left
Rotate Right
Rotate 180
Mirror

L
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(]
following:

e.

Tutorial: Creating a Simple Circuit

Drag and drop the ground to connect to the second resistor. Your layout should look similar to the

1

AN
1.0 [ohm]

__lwyo] o5z

to the first resistor so that they connect, as shown:

Insert an “Ammeter” from the “Components” tab in accordance with Appendix C. Drop the ammeter next

1.0 [ohm]

(yol sz
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2.4 Inserting Wiring

Insert wiring as follows:

Connect the source to the ammeter using “wire mode” in accordance with Appendix D. Your layout

should look similar to the following:

a.

la

——"

l 1.0 [ohm]
T
1.4

b. Connect the first and second resistors using the wire mode. Your layout should look similar to the

(wyol gz

following:

CEEyYYA

—

i} 1.0 [ohm]
T
o

(wyol gz
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PSCAD

2.5 Inserting an Output Channel and Data Label

Insert an output channel with data label as follows:

Insert the “Output Channel” from the “Components” tab in accordance with Appendix C. Drop the output

a.
channel below the electric circuit. Your layout should look similar to the following:

B e

1.0 [ohm]
W *
o

]
v Unfitled

fuye] gz

b. Use the wire mode to connect a short wire to the left of the output channel as shown:

18 A

({) 1.0 [ohm]
T
i

I
Untitled

[wyo] nsz
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Insert a “Data Label” from the “Components” tab in accordance with Appendix C. Drop the data label on
the end of the short wire. Your layout should look similar to the following:

C.

|
AN
1.0 [ohm]
[ ] (=]
1 (]}
o o
=)
=
3
P e Lo
SignalName! "Unitied

d. With the data label still selected (or left-click to select), in the “Component Parameters” pane, the default
name “SignalName” will be displayed.

Component Parameters 2 [&=
| Configuration hd
o 4 3

4 General
Data Signal Name SignalName

e. Rename the data label from “SignalName” to “la”.

Component Parameters b
| Configuration i
AR

4 General

Data Signal Name
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f.  Your layout should be similar to the following:

S
1.0 [ohm]

= (=]
Il (]}
v =
=)
o
3

:H_ lﬂ-

13, Untitied

2.6 Inserting a Graph

Create a graph to display the results in accordance with Appendix E.

2.7 Running a Case

Run a case as follows:

Compile the project by left-clicking on the “Run” button on the “Home” tab.

Project WView Tools Components

® AT A%
e Q‘ o s
et Wt
5| Copy ‘ue
Clean Build Build

Delet
et Modified ¥ ¥

board Compile

a.
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b. Once the case has finished running, the messages related to building the project will be listed in the “Build
Messages” pane.

Build Messages 2 [&=
© 0 Errors | ! 0 Warnings | |0 11 Messages | NewCase
lcon | Component Instance Description Namespace -~
_ Linking object code and
o libraries into binary NewCase
'NewCase.exe'
i ] Solve Time = 265ms MNewCase

Time used for loading
projectwith 'Add

References" 32ms NewCase

Note
If the “Build Messages” pane is not displayed, display it in accordance with Step 2.1.

c. Review the graph results as follows:
e The results will be displayed in the graph, and should look similar to the following:

Main : Graphs -
= Untitied ble
el

i s
i

i

L

x

060 070 080 080  1.00
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e To view the details during a specific time step, you may zoom in as follows:
o Hold the left mouse button down at the beginning of the period.

o Dragthe cursor to the end of the period. A rectangle outlining the selected time period will be
drawn.

= |ntitled
Tt

J o
il

G e

x 000 010 020 030 040 050

o Release the left mouse button. The graph will display the selected time period, and should look
similar to the following:

Main : Graphs

= Untitied bl

X 00250 0.0300 00350 0.0400 0.0450 0.0500 0.0550 0.0600 0.0850 0.0700 0.0750

4 L]

e To view the details of any other time periods, you may use the scroll bar at the bottom of the graph.

e Pressthe X and Y buttons on the keyboard to expand the output to the limits of the X and Y axis.
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Appendix A

Create a new project as follows:

a.

Creating a New Project

Tutorial: Creating a Simple Circuit

Invoke the “New Project” dialog box by using one of the following methods:

Press Ctrl-n.

Use the menu as follows:

1. Select "PSCAD" button ~J

2. Hover cursor over "New"

-

k. PSCAD (64-bit) Professional

E Home Project

View Tools

I New 4 I New Case
Q] Open » |

[

New Library

3. Select "New Case'

Select the “New Case” button from the “New” drop menu on the toolbar:

7

% PSCAD (64-bit) Profes

M Home Projet
E %' y Clean~
| D | G Build M

Paste x ; | Build~
Clipboard Comp

| New Library
E New Workspace
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Enter a name in the “New Project” dialog box, then select “Ok”.

b.

C.

Tutorial: Creating a Simple Circuit

<

o) New Project P4
|Genera| LI
o= 8l 3
4 General
Name C—
Type Case
Path C:\Users\Desktop
Name
A unigue name is required, starting with 'a-z, A-Z, 0-9'. The length cannot exceed 30
characters or contain any characters from:' /\:*?"<>| .~+-({}[]'@#5%" &

Note

Do not use any spaces in the name.

The new case will be listed in the “Workspace” window. For the purpose of this tutorial, this file is named

“NewCase” in the following view.

-

% PSCAD (64-bit) Professional

w Home Project  View
I*- Yo Cut ;f @
. /! Copy '
Paste Clean Build
Delet
ocete | "7 ited
Clipboard Compile

-

d-kE-»

Workspace

Untitled
=) Projects
-[J rmaster (Master Library)
B Jieucasd
£2] Simufation Sets
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Appendix B Inserting Components using the Master Library Page

Insert a Master Library component into your project (named “NewCase” for this instruction) using the Master
Library page as follows:

a. Left-click on “master (Master Library)” in the primary window.

Workspace L

Untitled

% Projerte
master (Master Libmr',r:]]

L enLdee
B] Simulation Sets

4| 1] | P

b. The library will be highlighted in the primary window, “Main” will be highlighted in the secondary window,
and the main categories of the library will be displayed on the canvas.

Woarkspace 2 [B  master:Main @I Start Pagel NewCase:Main 1
[ untitled - ~
(2 Project PASSIVE ELEMENTS SOURCES
_{! miester (Master Library) ]
P TTEWCoee
5] Simulation Sets
— — i 1.0 fohm] P
Y SR i —(rw-
1.0 [ohm] 1.0MH 1.0 [uF] > TIME
S :)4“‘
AN e —= (Delta
10fohm]  0.4H] 1.0 [uF) Three Phase
Run
. . I : A~
L 1.0 [ohm]  Fals
= + Single Phase @7
—3—nae .
1.0[ohm] M
More on Passive Elements More on Sources More an L
IMPORTS, EXPORTS & LABELS TRANSFORMERS
\ vy
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On the canvas, locate the required category, then double left-click on the arrow on the bottom right-hand

C.
side (for this illustration, the “Sources” category is being selected).

SOURCES

1.0 [ohm]

RGO
N
W) —]
Three Phase

| —h
1.0 [ohm]

@,

Single Phase

A

1.0 [ohm]

More on Sources

d. The selected category will be highlighted in the secondary window (in this example, “Sources”), and all
available components within this category will be displayed on the canvas.

2 B master:Main.Sources \E\l Start Pagel MNewCase:Main

Waorkspace
Untitled
Eﬂ Projects
a0 | master (Master Library)
i [J NewCase ' A
oo )
£] Simulation Sets single line diagram view
E o
n
S > x
< | 1] » _gé %
=- [ Main - _r
e =1 1 1

m

[Jsouree]

B VO_Devices
B Transformers
B Breakers_Faults

1.0 [ohmi
>
\Lv U \LPh
(SHERY
=
ERE® il

1
.
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Tutorial: Creating a Simple Circuit

e. Locate the required component. To determine a component’s properties, hover the cursor over the
component, and this information will be displayed.

¢
1

Component: master source_3

Instance; 36885620

Dezcription: Three Phase Woltage Source Model 2
Mame: Source 1

Sequence: [

Connection [M5]
NS

Source_3: Star connection
Sources

f.  Copy the component (right-click on the component, and from the displayed menu, left-click on “Copy”).

categories of the master library.

Double left-click on “Main” in the secondary window. This illustrates how to re-display the main

2 [B] master:Main.Sources @I Start Pagel MNewCase:Main

Workspace
Untitled
Bl Projects
-[J master (Master Library) PASSIVE ELEMENTS 14
={J NewCase
B] Simulation Sets
—+ —3+ —3+
e | G
1.0 [ohm] 1.0[H] 1.0 [uF]
il il ' N .
=0 pal 1.0 [ohm] 0.1[H] 1.0 [uF] re
= Shve 0
— M Sources = . . .||_( : Yy
— B Meters 1.0 [of
— /O_Devices - J___ 3 _
— B Transformers Single Phas
— B Breakers_Faults | C
-l Tlnes 1.0 o
-l Cables -
| W | ' More on Passive Elements q> Mare on
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h. Re-display your project (left-click on the project name in the primary window).

Workspace b

Untitled

< | 1] | p

i. Paste the component (place the cursor on the canvas and right-click; in the displayed menu, left-click on
“Paste”).

j. The component will be copied to the canvas.

Page 20



mm Tutorial: Creating a Simple Circuit

Appendix C Inserting Components using the Components Tab

Insert a component from the Master Library into your project using the “Components” tab as follows:

a. Left-click on the “Components” tab.

l-“‘;‘-“l| Home Project Wiew Tools | Components I Models

— Wire -4k Capacitor & XMode = Ammeter
~nnInductor |+ Ground '(é Breakout EF Voltmeter
“# Resistor | #™ Node Label | 4+ Pin Bus E Voltmeter to Ground

b. Left-click on the required component.

c. Move your cursor to the canvas. The component will follow your cursor as it moves over the canvas. Left-
click to drop the component onto the canvas.
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Appendix D Using Wire Mode

Wire mode enables the user to quickly draw interconnecting wires between components. Use wire mode as
follows:

a. Toinvoke wire mode, click the “Wire Mode” button in the “Home” tab or “Components” tab or press Ctrl
+ W on your keyboard.

b. Move the mouse pointer onto the project canvas. The mouse pointer will have turned into a pencil.
c. Draw a wire as follows:

e Position the cursor on the starting node and left-click. Move the cursor to the line end and right-click
to complete the wire.

e Multi-segment wires may be built by left-clicking at different points, then right-clicking at the line end.

R

d. Turn-off the wire mode using one of the following methods:
e Press the “Esc” key.
e Press Ctrl + W.

e Left-click on the “Wire Mode” button.
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Appendix E Adding Graphs to a Project

A graph is a special runtime object, which can reside only inside a graph frame. A graph frame is a special runtime
object container used for encapsulating overlay or polygraphs, and can be placed anywhere on the schematic
canvas. Once a graph frame has been added, you may then proceed to add as many graphs to it as you wish. The
graph is then linked to the output channel. Proceed as follows:

a. Adda graph frame. There are two methods for adding a graph frame, as follows:

e Right-click on a blank portion of the page and select “Add Component” | “Graph Frame”. A graph
frame will follow your cursor as it moves over the canvas. Left-click to drop the graph frame onto the
canvas.

e Left-click on the “Graph Pane” button in the “Components” tab of the ribbon control bar. Move your
cursor to the canvas. The component will follow your cursor as it moves over the canvas. Left-click to
drop the component onto the canvas.

e The graph frame will look similar to the following:

: Graphs =

Sec  gg0 040 020 030 040 050 060 070 0.80 080  1.00
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b. Add a graph to a graph frame. There are two methods for adding graphs to a graph frame, as follows:

e Right-click on the frame title bar and select “Add Overlay Graph (Analog)” or “Add Stacked PolyGraph
(Analog/Digital)”.

e Position your mouse pointer over the graph frame and press the “Insert” key on your keyboard.
e The graph and graph frame assembly will look similar to the following:

: Graphs

1.00

x 0.00 010 020 030 040 050 060 070 080 080  1.00

c. Link the graph to the output channel as follows:
e Hold down the Ctrl key, then drag and dropping the output channel to the graph.

e The graph and graph frame assembly will look similar to the following. The output channel’s name (in
this case, “Untitled”) becomes displayed.

Main : Graphs
= Untitled bie

L,
=]
=
L
1

x 010 020 030 040 050 060 070 030 090 1.00

=
=
=
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